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A tour of RStudio



[ N | ~/Desktop/demo-project - RStudio
Q -0y - B Go to file/function ~ Addins ~ R demo-project ~
Console Terminal Background Jobs [ Environment History Connections Tutorial -
R R4.3.1 - ~/Desktop/demo-project/ < [] 7 Import Dataset - % 121 MiB v ¥ List ~ | (&~
R - (7} Global Environment ~
R version 4.3.1 (2023-06-16) -- "Beagle Scouts"

Copyright (C) 2023 The R Foundation for Statistical Computing
Platform: aarch64-apple-darwin2@ (64-bit) Environment is empty
R is free software and comes with ABSOLUTELY NO WARRANTY.

You are welcome to redistribute it under certain conditions.

Type 'license()' or 'licence()' for distribution details.

Natural language support but running in an English locale

R is a collaborative project with many contributors. Files o ka0 (e PR e e Ere=entation =0
Type ‘contributors()' for more information and O -0 5 @
‘citation()' on how to cite R or R packages in publications. Q Home > Desktop > demo-project R
A Name Size Modified
Type ‘'demo()' for some demos, 'help()' for on-line help, or 'S
‘help.start()' for an HTML browser interface to help. U
Type 'q()' to quit R. ] .Rhistory 0B Feb 14, 20;
%] 01_getting-started.qmd 1.9 KB Jan 11, 202
> %] 02_visualizing-data.gqmd 1.9KB Jan 11, 202
% 03_manipulating-data.qmd 2 KB Jan 11, 202
] data
R demo-project.Rproj 258 B Feb 14, 20:
1 img
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Console

eoce ~[Desktop/d: project -
Q] - °$ & - =) 7 Go to file/function ~ Addins ~
Console  Terminal Background Jobs

‘R R4.3.1 - ~/Desktop/demo-project/

R version 4.3.1 (2023-06-16) -- "Beagle Scouts"
Copyright (C) 2023 The R Foundation for Statistical Computing
Platform: aarch64-apple-darwin2@ (64-bit)

R is free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute it under certain conditions.
Type 'license()' or 'licence()' for distribution details.

Natural language support but running in an English locale

R is a collaborative project with many contributors.
Type 'contributors()’ for more information and
‘citation()' on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-line help, or
"help.start()' for an HTML browser interface to help.
Type 'q()' to quit R.

R! demo-project ~

Environment History Connections Tutorial P |

Is awaiting your
LS e 0 e =010 i nStru Cti ons

Environment is empty

Type code here,

Files Plots Packages Help Viewer Presentation —=l
ter, and R
"] 42 Home > Desktop > demo-project R reSS e n e r' a n
A Name Size Modified
t. [ ] [ ]
() ®7 Rhistory 0B Feb 14, 20; WI ll ru n It
] % 01_getting-started.qmd 1.9KB Jan 11, 202

% 02_visualizing-data.qmd 1.9 KB Jan 11, 202

U | 03_manipulating-data.qmd 2 KB Jan 11, 202
[ £ data
] 'R demo-project.Rproj 258 B Feb 14, 20:
[ =1 img
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Your turn

[ 2O N J ~/Desktop/d project - Ji
Q- oﬁl =g = # Go to file/function - ~ Addins ~
Console  Terminal Background Jobs [

‘R R4.3.1 . ~/Desktop/demo-project/

R version 4.3.1 (2023-06-16) -- "Beagle Scouts"
Copyright (C) 2023 The R Foundation for Statistical Computing
Platform: aarch64-apple-darwin2@ (64-bit)

R is free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute it under certain conditions.
Type 'license()' or 'licence()' for distribution details.

Natural language support but running in an English locale

R is a collaborative project with many contributors.
Type 'contributors()' for more information and
‘citation()' on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-line help, or
"help.start()' for an HTML browser interface to help.
Type 'q()' to quit R.

£ demo-project ~

Environment History Connections Tutorial

(2 []  #Import Dataset ~ % 121 MiB ~
R -~ (7} Global Environment ~

Environment is empty

Files Plots Packages Help Viewer

QO -0 5 &~
Q Home > Desktop -~ demo-project
A Name

T .

] .Rhistory

% 01_getting-started.qmd
02_visualizing-data.qmd

03_manipulating-data.qmd
1 data

R demo-project.Rproj

[ img

7

&

Presentation

Size

0B
1.9KB
1.9KB
2 KB

258 B

=0

List - | &~

=0

]
R]
Modified

Feb 14, 20.
Jan 11, 202
Jan 11, 202
Jan 11, 202

Feb 14, 20:

>
—_—
e ——————

Type2 + 2
in the console

Press enter
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This is ephemeral though.

If you want to run this again, you'll have to type it again.

Store R code in a document instead
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Files pane

[ J
- —— All the files in your
Q- OR) | &2 - =] A Go to file/function o - Addins - R| demo-project ~ e es I you

Console  Terminal Background Jobs [ Environment History Connections Tutorial -
=1

[ ]
R R4.3.1 . ~/Desktop/demo-project/ 2 ] #Import Dataset -~ % 121 MiB - l’ = List ~ (&~
R - | @@ Global Environment - a Cu rre n Wo r I n
R version 4.3.1 (2023-06-16) -- "Beagle Scouts"

Copyright (C) 2023 The R Foundation for Statistical Computing
Platform: aarch64-apple-darwin2@ (64-bit) Environment is empty

[ ]
R is free software and comes with ABSOLUTELY NO WARRANTY. I | ecto ry

You are welcome to redistribute it under certain conditions.
Type 'license()' or 'licence()' for distribution details.

Natural language support but running in an English locale

R is a collaborative project with many contributors. Files | Plots | Packages | Help | Viewer | Presentation ED
Type 'contributors()’ for more information and So -0 5 {} - G
‘citation()' on how to cite R or R packages in publications. 0 Q Home > Desktop > demo-project R
A Name Size Modified
Type 'demo()' for some demos, 'help()' for on-line help, or rS
"help.start()' for an HTML browser interface to help. -
Type 'q()' to quit R. [ 7] .Rhistory 0B Feb 14, 20:
") % 01_getting-started.qmd 1.9KB Jan 11, 202
> I %7 02_visualizing-data.qmd 1.9 KB Jan 11, 202

| 03_manipulating-data.qmd 2 KB Jan 11, 202
[ £ data
[} IR demo-project.Rproj 258 B Feb 14, 20.
[ ] img
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Your turn

]
[ 2O N J ~/Desktop/d project - i @
O -y - B # Go to file/function - ~ Addins ~ R demo-project ~ FI n d Q 1 — ge t t 1 n g =

Console  Terminal Background Jobs [ Environment History Connections Tutorial -

‘R R4.3.1 - ~/Desktop/demo-project/ .2 [ 7 Import Dataset ~ % 121 MiB - ¥ List ~ | &~

R - (7} Global Environment ~
R version 4.3.1 (2023-06-16) -- "Beagle Scouts"
Copyright (C) 2023 The R Foundation for Statistical Computing
Platform: aarch64-apple-darwin2@ (64-bit)

started.qmd

Environment is empty

R is free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute it under certain conditions.
Type 'license()' or 'licence()' for distribution details.

Natural language support but running in an English locale

1 I .t t
R is a collaborative project with many contributors. Files Ky e = DI =i == entation =0
Type 'contributors()' for more information and e -8 =] {} A @
‘citation()' on how to cite R or R packages in publications. 42} Home > Desktop > demo-project R ..

A Name Size Modified
Type 'demo()' for some demos, 'help()' for on-line help, or rS
"help.start()' for an HTML browser interface to help. N
Type 'q()' to quit R. ] .Rhistory 0B Feb 14, 20:
% 01_getting-started.qmd 1.9KB Jan 11, 202
> I % 02_visualizing-data.qmd 1.9 KB Jan 11, 202
03_manipulating-data.qmd 2 KB Jan 11, 202
] data
R demo-project.Rproj 258 B Feb 14, 20:
[ img
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Source pane

oo B Documents
Q- ol B | & | A Gotofile/function ~| - Addins ~ & demo-project ~

% | 01_getting-started.qmd P | Environment History Connections Tutorial -
‘] & [ /RenderonSave =, (O b Render - I #Run - | % - | <2 [ Import Dataset ~ % 140 MiB ~ & =Lst ~ | (&~
Source | Visual = Outline R ~ } Global Environment ~ Q o e n e re
1v f--
2 title: "Getting started with R and RStudio"
3  format: html Environment is empty
44 ---
5
6~ "' {r} z

7 #| label: setup
8 #| warning: false
9 #| message: false
10

11 library(tidyverse) Fil\es Plots P?ckages Help Viewer Presentation =E|
124 Qo -0 5 &~ c
13 () 42 Home > Desktop > demo-project =B
14 - ## Quarto A Name Size Modified
15 t
1:1 [ Getting started with R and RStudio Quarto + . -
] .Rhistory 0B Feb 14, 20.
Console [ Terminall% || Background fobs =0 & 01_getting-started.qmd 19KB  Jan 11,202
G RAELS o fRES T EGE-CRlEY %) 02_visualizing-data.qmd 19KB  Jan 11,202
R version 4.3.1 (2023-@6-16) -- "Beagle Scouts” ‘J | 03_manipulating-data.qmd 2K8 Jan 11, 202
Copyright (C) 2023 The R Foundation for Statistical Computing [J ] data
Platform: aarch64-apple-darwin2@ (64-bit) 0O ® demo-project.Rproj 258 B Feb 14, 20;
[ =1 img

R is free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute it under certain conditions.
Type 'license()' or 'licence()' for distribution details.

Natural language support but running in an English locale

R is a collahorative nroiect with manv contributors.
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% 01_getting-started.qmd

‘| & | |RenderonSave ', O @ s} Render

Source = Visual

1y ---

2 title: "Getting started with R and RStudio"
3 format: html

44 ---

5

6~ " "{r}

7 #| label: setup

8 #| warning: false

9 #| message: false

10

11 library(tidyverse)

12« °°°

13

14 ~ ## Quarto

15

1:4 E3 Getting started with R and RStudio %

a

- Document format

=$Run ~ &, ~

that combines

text and code

- Acts like a
notebook for
your analysis
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[ O N ~IDe:

O -~ Bl = | A Gotofile/function - Addins ~

% | 01_getting-started.qmd
& & [ /RenderonSave =, ( b Render o

Source | Visual

Id project - 5

= D

& C] ¥ #Run + G -
= Outline

14 ## Quarto
i3

16| This is a [Quarto](https://quarto.org/) file (it has a .gmd file extension). When you execute code

within the file, the results appear beneath the code.
aly/

18| R code goes in **code chunks**, denoted by three backticks. Try executing this chunk by clicking the

pressing *Ctrl+Shift+Enter* (or *Cmd+Shift+Enter* on Mac).

*Run* button (a small green triangle) within the chunk or by placing your cursor inside it and

19
20~ "7 {r} z
21 ggplot(data = mpg) +
22 geom_point(mapping = aes(x = cty, y = hwy), alpha = 0.2)
234
Sy X
° °
°
40-
°
e o
°
°
° °
1:4 3 Getting started with R and RStudio % Quarto =
Console  Terminal Background Jobs ==

‘R R4.3.1 . ~/Desktop/demo-project/

> library(tidyverse)

> ggplot(data = mpg) +

+ geom_point(mapping = aes(x = cty, y = hwy), alpha = 0.2)
>

R demo-project ~

Environment History Connections Tutorial -
< {7 Import Dataset ~ N 216 MiB ~ = List~ (-

R - (7} Global Environment ~ Q

Environment is empty

Files Plots Packages Help Viewer Presentation =
QO -0 5 &~ @
O Q Home > Desktop > demo-project R
A Name Size Modified
L
[J ©] .Rhistory 0B Feb 14, 2024
") % 01_getting-started.qmd 1.9 KB Feb 14, 2024
| 02_visualizing-data.qmd 1.9 KB Jan 11, 2024,
¥ 03_manipulating-data.qgmd 2 KB Jan 11, 2024,
[ £ data
R demo-project.Rproj 258 B Feb 14, 2024
[ =1 img

Text
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L CN ~IDe:

Q- - Bl = | A Gotofile/function

% | 01_getting-started.qmd
& & [ /RenderonSave =, (O b Render -
Source = Visual

14 ~ ## Quarto
i3

1d

project -
= D
FRun - ‘G -
= Outline

16 This is a [Quarto](https://quarto.org/) file (it has a .gmd file extension). When you execute code

within the file, the results appear beneath the code.
17

18 R code goes in **code chunks**, denoted by three backticks. Try executing this chunk by clicking the
*Run* button (a small green triangle) within the chunk or by placing your cursor inside it and

pressing *Ctrl+Shift+Enter* (or *Cmd+Shift+Enter* on Mac).

il
24~ " {r} z
21 ggplot(data = mpg) +
22 geom_point(mapping = aes(x = cty, y = hwy), alpha = 0.2)
23
° °
40-
°
e o
°
°
° °
1:4 [ Getting started with R and RStudio % Quarto =
Console  Terminal Background Jobs ==

‘R R4.3.1 . ~/Desktop/demo-project/

> library(tidyverse)

> ggplot(data = mpg) +

+ geom_point(mapping = aes(x = cty, y = hwy), alpha = 0.2)
>

Environment History Connections Tu
=< [# Import Dataset ~ % 216 MiB ~
R - (7} Global Environment ~

Environment is empt:

Files Plots Packages Help Viewer
QO -0 5 &~
\:\Q Home ~ Desktop ~ demo-project
A Name

t.
[ ©] .Rhistory
) % 01_getting-started.qmd
%) 02_visualizing-data.qmd
% 03_manipulating-data.qmd
1 data
[} [ demo-project.Rproj

[ =1 img

torial

s

y

$J demo-project ~

Presentation —i=l
@
(R

Size Modified

0B Feb 14, 2024

1.9 KB Feb 14, 2024

1.9 KB Jan 11, 2024,

2 KB Jan 11, 2024,

2588 Feb 14, 2024
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[ ON ) ~|De: /d project -
O -%pl- Bl = A Gotofile/function o
% | 01_getting-started.qmd =
& Pl [ /RenderonSave =, ( s} Render o a SRun - | % -
= Outline

Source = Visual

14 ~ ## Quarto
i3

16 This is a [Quarto](https://quarto.org/) file (it has a .gmd file extension). When you execute code

within the file, the results appear beneath the code.
17

18 R code goes in **code chunks**, denoted by three backticks. Try executing this chunk by clicking the
*Run* button (a small green triangle) within the chunk or by placing your cursor inside it and

pressing *Ctrl+Shift+Enter* (or *Cmd+Shift+Enter* on Mac).

19
20~ " 7 {r} z
21 ggplot(data = mpg) +
22 geom_point(mapping = aes(x = cty, y = hwy), alpha = 0.2)
2B ~
Sy X
° °
40-
°
e o
°
°
° °
% [ Getting started with R and RStudio % Quarto =
Console  Terminal Background Jobs =]

(R R4.3.1 . ~/Desktop/demo-project/

> library(tidyverse)

> ggplot(data = mpg) +

+ geom_point(mapping = aes(x = cty, y = hwy), alpha = 0.2)
>

R/ demo-project ~

Environment History Connections Tutorial P |
(= [# Import Dataset ~ % 216 MiB ~ { = List ~ | ( :J -
R ~ (7} Global Environment ~ Q

Environment is empty

Files Plots Packages Help Viewer Presentation =
QO -0 5 &~
() 42 Home > Desktop > demo-project ®
A Name Size Modified
T .
_J ] .Rhistory 0B Feb 14, 2024
") % 01_getting-started.qmd 1.9 KB Feb 14, 2024
| 02_visualizing-data.qmd 1.9 KB Jan 11, 2024,
| 03_manipulating-data.qmd 2 KB Jan 11, 2024,
[) £ data
[} IR demo-project.Rproj 258 B Feb 14, 2024
[ 1 img

Text

Code
Output
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Your turn

eoe ~/Desktop]d
O-%ple- B = || A Gotofile/function | - Addins -

4| 01_getting-started.qmd

& A RenderonSave = ; (Q  up Render -

Source = Visual

14 ~ ## Quarto
i3

project -

=D
FRun - ‘G -

= Outline

16 This is a [Quarto](https://quarto.org/) file (it has a .gmd file extension). When you execute code
within the file, the results appear beneath the code.

17

18 R code goes in **code chunks**, denoted by three backticks. Try executing this chunk by clicking the
*Run* button (a small green triangle) within the chunk or by placing your cursor inside it and
pressing *Ctrl+Shift+Enter* (or *Cmd+Shift+Enter* on Mac).

il
24~ " {r} z
21 ggplot(data = mpg) +
22 geom_point(mapping = aes(x = cty, y = hwy), alpha = 0.2
23
°
°
40-
°
' °
] ) )
1:4 E3 Getting started with R and RStudio + Quarto +
Console  Terminal Background Jobs ==

‘R R4.3.1 . ~/Desktop/demo-project/
> library(tidyverse)

> ggplot(data = mpg) +

+ geom_point(mapping = aes(x = cty,
>

y = hwy), alpha = 0.2)

R| demo-project ~

Environment History Connections Tutorial P |
% [ 7 Import Dataset - % 216 MiB + Lst - | @~
R - (7} Global Environment ~
Environment is empty
Files Plots Packages Help Viewer Presentation —i=l
Q19 -0 5 &- ‘
Q Home ~ Desktop ~ demo-project R]
A Name Size Modified

t.

] .Rhistory 0B Feb 14, 2024
01_getting-started.qmd 1.9KB Feb 14, 2024
02_visualizing-data.qmd 1.9 KB Jan 11, 2024,

% 03_manipulating-data.qmd 2 KB Jan 11, 2024,

1 data

R demo-project.Rproj 258 B Feb 14, 2024

[ img

Read the
Instructions

un the code chunk

y clicking the play
button
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Add a new chunk

Put 2 + 2inthe chunk and run it
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Render

Render a Quarto document into a standalone shareable file

% | 01_getting-started.qmd
& b _|Render on Save Q‘ a) Renderl > 4

Source Visual

@ Render HTML

- . =8 Render PDF
2 title: "Getting started with
B £ormat : W] Render MS Word

A html -+ Aafanl+t+
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The best way to combine R code and narrative

We'll use it throughout the workshop

I'll provide starter code

You'll complete "Your turns"

In the end, you'll have an annotated record for yourself
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Spot the difference:

filter(mtcars, cyl == 4)

four_cyls <- filter(mtcars, cyl == 4)

Find these chunks in the notebook and run them.

What's different about what happens?

19/33



<- assigns the output from the righthand side to a variable with
the name on the lefthand side

four_cyls <- filter(mtcars, cyl == 4)
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Environment pane

List of all the

Environment History Connections Tutorial — - 1
= 7/ Import Dataset ~ % 250 MiB ~ & = List - | & -~ Varlables you Ve
R ~ (7} Global Environment ~ Q Created

Data

@ four_cyls 11 obs. of 11 variables
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Find four_cy1ls in the environment pane.
Click on the name four_cyls

What happens?
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&Y 01_getting-started.qmd \:] four_cyls =
& s 5/ Filter
“ mpg cyl disp hp drat wt qsec vs am gear carb
Datsun 710 22.8 4 108.0 93 3.85 2.320 18.61 1 1 4 1
Merc 240D 24.4 4 146.7 62 3.69 3.190 20.00 1 0 4 2
Merc 230 22.8 4 140.8 95 3.92 3.150 22.90 1 0 4 2
Fiat 128 324 4 78.7 66 4.08 2.200 19.47 1 1 4 1
Honda Civic 30.4 4 75.7 52 4.93 1.615 18.52 1 1 4 2
Toyota Corolla 33.9 4 71.1 65 4.22 1.835 19.90 1 1 4 1
Toyota Corona 21.5 4 120.1 97 3.70 2.465 20.01 1 0 3 1
Fiat X1-9 27.3 4 79.0 66 4.08 1.935 18.90 1 1 4 1
Porsche 914-2 26.0 4 120.3 91 4.43 2.140 16.70 0 1 5 2
Lotus Europa 30.4 4 95.1 113 3.77 1.513 16.90 1 1 5 2
Volvo 142E 21.4 4 121.0 109 4.11 2.780 18.60 1 1 4 2

Showing 1 to 11 of 11 entries, 11 total columns

Clicking on an
object in the
environment panel

opens it an
interactive viewer
tab
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four_cyls <- filter(mtcars, cyl == 4)

Functions do things
Functions take arguments, output results

If you want to keep the output, assign it to a variable
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To look up the help page for an R function,
type this in the console:

?function_name

(Or google it!)
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Help pane

Files Plots Packages Help Viewer Presentation .
@ D Q & L filter CIREGE
R: Keep rows that match a condition ~  Find in Topic

filter {dplyr} R Documentation

Keep rows that match a condition

Description

The filter () function is used to subset a data frame, retaining all
rows that satisfy your conditions. To be retained, the row must
produce a value of TRUE for all conditions. Note that when a
condition evaluates to NA the row will be dropped, unlike base
subsetting with [.

Usage

filter(.data, ..., .by = NULL, .preserve = FALSE)

These help pages

prove details about

the arguments you
can supply a
function

Often full of

examples
at the bottom
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Look at the help page for seq

Add a chunk that uses seq() to create a

list of numbers from 5 to 100, spaced by 5
(so 5, 10, 15, 20, ...)

02:00
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seq(from = 5, to = 100, by = 5)

##  [1] 5 10 15 20 25 30 35 40 45 50 55 60 65 70
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Common syntax problem #1

Missing closing parentheses or quotes

mean (mtcars

"Oops this is wrong
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Common syntax problem #2

Surrounding something in quotes when it should be (or vice versa)

mean("mtcars")

## Warning in mean.default("mtcars"): argument is not numeric or

## [1] NA
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There are three chunks under "Syntax gone wrong"

Run each, read the error message, and try to fix the syntax
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Cheatsheets

Go to Help > Cheatsheets to find quick
reference guides to different packages

RStudio IDE : : CHEATSHEET

Documents and Apps  Source Editor Tab Panes Version
| Gashoy R, (e Opmine See Frgac Complecs hn | Impordita Ssoylput Mg Wow Ao

B ) 7 S e i BRI AT RSP M WETSR S s o, o Control

<~ andmore in Source Pane fon ‘code unjcops detabases usage + Nmnnm“h,m[mompm,w

T PTG = ed
Check  Render Choose Configure Insert * & ] #dded Mod  Untrackec
Sooihg ootpor oot onde ™ Cote. s | S msnaes STanns ot s eSS G gt mReome
oo opons _chunk. o semer el e e T ST I
e i Souceifinar shaifle o Gagediles toremote Hisiry branch
TR e, genn - Soveeiinor sheifle U ek seehinsce
: oy workspace | worksoace workspace  cnronment i)
$ s s R showtie viial — c dspayrom Displayabiec
oot e, R Showfe e e e e et o Dipley o Opnsheloype commands
7 chunk  chunk {reverse P00
i oy Cotedigrosicthatsppearinthe o, 3 -
a fun Hor e dogmes SRS e s i
B allprevious  Run this Bttt U syntax highi rnmm - :
L Jumpto codechunks codechunk | | 1.5 o o s xtens oo -
FEEs ol i —
) setitc ol I Tabco g Viewiraa Viewtuiion
38 e chunk, Z names, file pa m arguments, and more.  type with short description viewer
i churk & o -
Access markdown guide at H - Mult-languzge code snippets. K o A e
e e feren 2 e e ehcode. |3 vmg b = iaretle : . |Debug Mode
8 dow torance = ﬂ o o Mol
ee reverse side for more on Visual Editor & dymp o functionin il Changefiletype ¢ reare pelete forome | range’ | s debug), browser()or  brespon:and xeute
. wsins folder il directory | yourcode 1o open the debugger
Fstudm vecogmzes (hax fles named app.R, Console  Terminal - & Markdown - Jobs. =}
rver.R, ui.R, a belong to shinyapp. = mhmmm)mmrmmy Launch debugger  Opentraceback to examine
3 T LSRR T ©) agpn 10,2021, 621 P mode from origin  the functions that R called
¥ —— a3 ting ™, minsapisin  Maimite e e oo e
: B Diectoly " Sepotbsesions Mimzepanes |t o o
§ R Choose " Blblishto Mansge | | 13-4 o e promser keyod toyourwering directoy. ="
H spp locetionto shinyappsio publish || Swataamm - UCT0 ENadoun - praggne : .
H viewapp  orserver  accounts toseehistory Buildlog  boundaries [RiEe—
Package Development Cicknox tolinenumberto  Highighed e shows here
Cpeateanewpacageuth FY-i e o b e
o o> Now Project > New Directory > R Package 5
vigate "Open'r Export " DRidE™ Delte
Enable caygen documentationwith o Spenin Homepageol “Seachuihin "Searchfor
Tools praject ptions > Buld Taols receniploss widow plotplal - allplos - |[QTERAEEOT TR reie

Roxygen guide at Help > Roxygen Quick Reference

Tab Viewer pane displays HTHL content, such s Shiny
207, RaFAd i T4, A e v 7t

See package information n the By

Instal packcge Lalty ~ e
and reload changes " 2 < L1
Ny G i G T =] o Stop Shin Refresh
| e e 1 rowse Pty rpibs, RSCoNNech, elres Select function
T packagesite enviionmentwhere  inexecuting i Vaceback (o
RunRCMD e Cle:m;lg:\ R o ‘execution has paused  environment.
check o —— View(<data>) cpens spreadshee e view of ot st
ustormize et | R ck o oad peckage with Packagé  Delete = = o T
oackage build ey package brary().Unclick o cetach ~ version il e i emy e T Console [QIermnaigiots =0
options <oty | et package with detach(). installed _library sl s smal ml esen mmi o Ne | B ) Continue M stop

Filterrows by value Sortby  Search Stepthrough ~ Siepintoand  Resume  Quitdebug
orvaluerznge values forvalue codeonelne outoffunctions  execution made

% os't~ atatime on
B ShPositSofware,PBC + info@positco + posic - i o+ HTHL P  Rotudio DE 2023.06.14524 - Updted: 202307
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Data basics



